Layers are one of Photoshop’s most powerful features. Think of layers as transparencies stacked on top of each other, where each layer can have different objects, pictures, etc. that can be moved and edited separately of each other within a Photoshop document.

Layers are located in the Layers Panel, which depending on which workspace is selected, may be located on the bottom right side of the Photoshop Window.

If the Layers Panel is not visible, it can be added by going to the Window Menu and selecting Layers, or by pressing F7 on the keyboard.
The Layers Panel
On the bottom of the layers panel, there are seven buttons that can be used for visual manipulation or for layer organization.

A. **Link Layers** – Allows layers to be linked together so they can be edited, moved, etc as a single layer.
B. **New Layer Style** – Add styles to layers such as, drop shadows, bevel and emboss, stroke, etc.
C. **Add Layer Mask** – Allows for the ability to control the transparency of all pixels within a layer.
D. **New Adjustment or Fill Layer** – Allows for non-destructive adjustments to layers such as brightness and contrast, hue/saturation, gradient, etc.
E. **New Group** – Creates a group of layers that can be moved, edited, and or selected together as one layer.
F. **New Layer** – Creates a new layer within the Layers panel
G. **Delete Layer** – Deletes the selected layer(s) within the layers panel

The Background Layer
When an image is opened, or a new document is created with a white or colored background, that image or document will contain a single layer called the Background layer.

An image can only have one background layer and the background layer order cannot be changed in the order of layers, it must always be the bottom layer. Neither the blending mode nor the opacity of a background layer can be changed. If changes need to be made on the background layer, the layer must be converted into a regular layer.
To change a background layer into a regular layer, double click on the background layer within the Layers panel, which will populate the New Layer window. In the New Layer window, the default name for the new layer will be Layer 0. A new layer name may be typed into the Name text box. When the layer has been named, click on the OK button.

The Background layer will now become a regular layer that can be moved, blending modes may be added to it, as well as the ability to change the opacity on the layer.

The background layer can also be changed to a regular by going to the Layer menu, selecting New, and then selecting Layer from background.

**Note:** If a new document is created with a transparent layer, that document will contain a regular layer called Layer 1 and will not have a background layer.

### Rename a Layer

Renaming layers within Photoshop can make it easier to determine which layer is which when editing a document. To rename a layer within Photoshop, double-click on the current layer name in the Layers panel. The layer name will become highlighted and can either be typed over with the new name, or one can hit the delete key to delete the text, and then type in the new name. When the new name has been typed, hit the Enter key to accept the new name.

### Create a New Layer

To create a new layer on an existing document, click on the Create a new layer icon (it looks like a piece of paper with the lower left corner folded) on the bottom of the layers panel.

**Note:** When a new layer is created, it will be placed on top of the layer that was selected prior to creating the new layer.

The new layer will be given the default name of Layer 1, 2, 3, etc. To change the name of the layer, double click on the layer name to select the existing name and then type in a new name for the new layer.
Another way to create a new layer is to click on the fly-out menu on the upper left corner of the Layers panel, and then select New Layer.

The New Layer window will appear which will allow users to enter in a new name for the layer before creating the layer. It is recommended to type in a unique layer name and then click on the OK button to create the new layer within the Layers Panel.

**Tip:** The shortcut to create a new layer is Shift+Ctrl+N.

### Duplicate a Layer

Duplicating a layer will make an exact copy of an existing layer so the layers can be edited independently. To duplicate a layer, click, hold, and drag the layer to be copied over the New Layer icon, which is located on the bottom of the layers panel.

Photoshop will produce an identical layer with the same name as the original layer with the text copy after it. To rename the duplicated layer, double click on the layer name and type in the new name.

A layer can also be copied by right clicking on the layer to be duplicated, then select Duplicate layer from the menu. When duplicating a layer this way, Photoshop will ask to rename the new layer.
Reorder Layers

Layers work like transparencies in that the layer on top covers the layers below it. Any layer within the layers panel, with the exception of the background layer, can be moved in the layer order.

To reorder any of the layers, click and hold on the layer that is to be moved and drag into the new location. As the layer is being dragged through the layers panel, a line will appear to show where the layer will be placed.

When the line appears in the correct location, let go of the mouse button to place the layer in the new location.

Move Objects on a Layer

A layer can contain one object or many objects. In order to move an object on a layer the layer must first be selected from the Layers panel. With the layer selected, select the Move tool (V) from the toolbox and then click, hold and drag the object to its new destination.

Note: The background layer cannot be moved until after it’s been renamed.

Show and Hide layers
Layer Visibility
To the right of every layer in the layers panel there is an eyeball icon which indicates layer visibility. When the eyeball icon is visible, it means that the layer is visible. To toggle the visibility of a layer on and off, simple click on the eyeball icon.

Layer 0 and Layer 1 are both visible

![Layer Visibility Example](image)

Layer 0 is visible; Layer 1 is not visible

![Layer Visibility Example](image)

Lock Layers
Any layer within the layers panel can be locked to protect its contents from being changed entirely, or a layer can be locked to prevent it from being moved, any pixels being changed, or any changes to the transparency on the layer.

To lock a layer, select the layer within the layers and then select the appropriate lock icon, which are located on the top of the layers panel.

Lock options;
- Lock Transparent pixels - Confines editing to the opaque portions of the layer.
- Lock image pixels - Prevents modification to the layer’s pixels using the painting tools.
- Lock Position - Prevents the layers pixels from being moved.
- Lock All - Prevents any modifications of any piece of the layer.

When a layer has been locked, a padlock icon will appear next to the layer name within the layers panel. The icon will appear differently depending if there is a full lock (Solid Lock), or a partial lock (Hollow lock) on the layer.

![Locked Layers Example](image)
Delete Layers
Deleting a layer that is no longer needed in a Photoshop document will reduce the file size and help improve any unnecessary clutter in the Layers Panel.

To delete a layer within Photoshop, right click on the layer to be deleted and select Delete Layer.

By default, any time a layer is deleted this way, Photoshop will verify that the layer is actually supposed to be deleted. To delete the layer, click on the OK button.

A layer can also be deleted by clicking and holding on the layer to be deleted and then dragging the layer to the trash can, which is located on the lower right side of the layers panel.

When deleting a layer by dragging the layer to the trash can, Photoshop will automatically delete the layer without verifying. If a layer was deleted by mistake, use the undo shortcut of Ctrl-Z to undo the deleted layer, or navigate to the history panel to undo the last state.

Tip: If the delete or backspace keys are clicked while a layer is selected, that layer will be deleted without any verification from Photoshop.

Link Layers
By default, all layers are independent of each other, so any changes that are done to a layer will only effect the selected layer. Linking layers together can be very beneficial when several layers are related to each other. Any movement, resizing, blending, etc. that is done to one layer, will be done to all other layers that are linked.

To Link layers, select the layers to be linked and then click the Link icon in the bottom left corner of the Layers Panel.
Once the layers have been linked, a link icon will display to the right of all layers that are linked, as one as one of the linked layers is selected.

To unlink the layers, select the layers and click on the Link Icon in the layers panel.

**Layer Groups**

Layer Groups work similar to linking layers in that the layers within a group can be moved, resized, blended etc. together. The benefit of Layer groups is the ability to add and remove single layers into groups, the ability to make changes to individual layers within the group that won’t affect other layers within the group, and for the purpose of organization if the document that is being created has multiple layers, which will space within the Layers Panel.

**Create a Layer Group**

Create a Layer Group by clicking on the New Group icon in the Layers Panel.

The group will be created with the default naming scheme of Group 1, Group 2, etc. To rename the group, double click on the Group name. With the name selected, either type in the new name, or delete the text and type in a new group name.
**Place Layers in a Layer Group**

When a Group is created, it is created with no layers in it. To add layers into the group, layers from the Layers Panel must be selected and drug into the new group. To do this, click, hold, and drag the desired layer below the group name. When the layer is being drug, there will be a faint line that will appear under the group name to show that the layer has been added to the group. When this line appears, let go of the left mouse button to place the layer within the group.

To verify that a layer has been added into a group, look at the layers panel. Any layer that is a part of a group will be indented underneath the Group name. Any layer that is not indented, is not a part of the layer group.

A layer group can also be created by selecting multiple layers to be placed in a group. To select multiple layers, click on the first layer, then press and hold the Ctrl key while clicking on the other layers. When the layers are selected, click, hold, and drag the layers to the Groups icon (folder icon) on the bottom of the layers panel.

When a group is created this way, the selected layers will be placed within the group automatically. The group will have a default name of Group 1, Group 2, etc. and the group will be collapsed.

To view the layers within the group, click on the right arrow to the left of the group name, which will expand the collapsed group.
Layer Styles

Layer styles are used to add special effects to text and images. Photoshop includes some pre-built Layer Styles that can be applied to layers and text or users can create Custom Styles. Multiple layer styles can be applied to a single layer. All layer effects will display as sub-items under the selected layer in the Layers Panel, so the layer effects can be viewed or unviewed by clicking on the eye icon next to the effect.

Layer Styles include effects such as drop shadow, bevel and emboss, inner shadow and stroke, along with many other effects. The Layer Styles can be added by right clicking on the layer to add a style to and selecting Blending Options.

Tip: Layer Styles cannot be applied to a background layer or a locked layer. To apply a style to the background layer, the background layer must be renamed from the default name of Background, which will turn the layer into a regular layer.

Layer styles can also be added by selecting the layer to add the style to, and then navigating to the Layer Menu on the top of the Photoshop window, and selecting Layer Style.

When adding layer styles, the Layer Style window will appear. The window consists of the available styles on the left side of the screen, options based on the style that was chosen in the middle, and a preview on the right side of the screen.
To select a style to be added to layer, click in the checkbox to the left of the style. Multiple styles are able to be added to a layer, just make sure each style to be added has a checkbox next to it. As styles are added, the preview window, which is located on the right side of the screen, will display how the styles will look.

Each style will have options that can be adjusted, such as stroke color, size and position, drop shadow opacity, angle, distance, color, etc. To view the options for a selected style, click on the name of the appropriate style on the left side of the window, so the style name is highlighted. Any options that are available for that particular style, will display in the middle of the Layer Style window. The preview on the right will change as any options are changed.

When the styles have been selected and adjusted, click on the OK button on the right side of the menu to add the styles to the layer.
Copy Layer Styles
When a layer style is created, that particular style can be copied and applied to any other layers within the document. To copy a layer style, right click on the layer that has the style to copy, then select Copy Layer Style.

Now navigate to the layer to add the style to, right click on the layer, then select Paste Layer style.

Type Tool
The type tool is used to add text to a document. To add text, select the Type Tool from the tool bar. When the type tool is selected, there will be options to select the font style, font size, color, alignment, etc. on the Type Tool options bar.

To add a text layer onto an image, move the cursor to the location on the imager where text is to be added and then click, hold, and drag to create a text box. Getting the size perfect isn’t extremely important immediately, as the text box can be resized if need be.

When a type layer is added in Photoshop, a new layer will be created within the layers panel. The layer name for the type layer will display as the actual text that is typed into the textbox on within the document. To rename the layer to a more meaningful name, double-click on the type layer and from the Layer Properties dialog box, type a new name.

If the text that is within a text box ever has to be changed, the Type Tool must be selected before any text can be edited. Once the type tool is selected, move the cursor over the text within the document and click on the text to select it. When the text has been clicked on and selected, it may be edited.
Format Text

Formatting paragraph text is made easy when using the Type tools in the Options bar.

![Type Tool Options Bar]

Note: The Type tool must be selected in the tool box in order for the tools to appear in the Options bar.

Formatting options can be chosen from the Options bar prior to typing text or typed text can be selected and then formatted.

**Text Size**

To change the text size, select the Type tool from the toolbox. With the Type tool selected, click, hold and drag the cursor over the text to be changed within the document. When the text has been selected, select a new font size from the Font Size pull down menu which is located on the Type Tool Options bar.

**Text Color**

To change the text color, select the Type tool from the toolbox. With the Type tool selected, click, hold and drag the cursor over the text to be changed. When the text has been selected, select a different color from the Font Color icon located on the Type Tool Options bar.

Tip: It is may be difficult to see the change in the color of text because of the highlight on the text selection. To remove the visible highlight from the selected text, press the shortcut key Ctrl-H to toggle the highlight off/on for the selected text.

**Anti-Aliasing**

Anti-Aliasing will smooth out the edges of text and blend the edge colors so that the text does not appear jagged.

Anti-Aliasing is recommended for web graphics that contain text larger than a 14-point size. Applying anti-aliasing to text layers with a font size of less than 14 points could cause the text to blur or be not as readable.

To apply anti-aliasing to text, select the Type tool from the toolbox. With the type tool selected, click, hold and drag the cursor over the text. When the text has been selected, click on the Anti-aliasing (indicated by the aa icon in the Type Tool Options bar) drop down to select Sharp, Crisp, Strong, or Smooth.

Tip: Typically, larger text sizes appear better with either Smooth or Strong anti-aliasing, whereas smaller text sizes appear better with Crisp or Sharp. It may be useful to select a couple anti-aliasing options to compare and choose the best option for the particular font and font size that is being used.
Character and Paragraph Formatting

More text formatting options can be displayed by selecting the Character and Paragraph panel. To open the Character panel, navigate to the Window menu and select Character. The Character panel, indicated by a capital A with a vertical line next to it, will open on the right side of the Photoshop window.

Tracking

Tracking adds spacing between all of the selected characters within a textbox. The Tracking tool is located in the Character Panel and is indicated by a VA icon with an arrow underneath it.

To add spacing between selected characters in a text layer, select the Type tool from the tools from the toolbox. Next, position the cursor within the textbox and select the characters where spacing needs to be added. When the text has been selected, choose a number from the tracking drop-down menu, or type a number in the tracking textbox between the range of -1000 and 10,000.

Note: Negative numbers move the character closer together and positive numbers move the characters farther apart.

Tip: Tracking can also be done by selecting the text within a textbox and then holding the Alt key while hitting the right arrow (increase) or left arrow (decrease) keys to change the tracking between characters.
**Kerning**

Kerning is the amount of space between two characters within a textbox. The Kerning tool is located in the Character Panel and is indicated by a V/A icon.

To add kerning between two characters in a text layer, select the Type tool from the toolbox. Next, position the cursor between the two letters where spacing needs to be added. When the cursor is the correct location, choose a number from the Kerning drop-down menu or type a number in the Kerning field between the range of -1000 and 10,000.

**Note:** Negative numbers move the character closer together and positive numbers move the characters farther apart.

**Tip:** Kerning can also be applied without going through the Character Panel. Select the Type tool from the toolbox and then position the cursor between the two characters to apply kerning to. Now press and hold the Alt key while hitting the left (increase) or right arrow (decrease) to adjust the kerning.

**Rasterizing Type**

A Photoshop warning box may appear when applying Filters to text layers. The warning message will state that the type layer must be rasterized before proceeding. When rasterizing the type in a text layer, the layer will change to fixed pixels and will not allow text editing.

**Spell Check Text**

Photoshop does have a built-in spell checker that can be used to check the spelling of all text layers within a document. To use the spell checker, navigate to the Edit Menu, and select Check Spelling.

**Tip:** When using the spell checker, make sure the type tool is not selected. If the type tool is selected, the spell checker will only check the spelling on the text layer that is selected within the layers panel, not every layer that contains text.
Photoshop will pause when it finds a possible error, and the word in question will appear in the Check Spelling Dialog box. Photoshop will offer Suggestions to the word in question. If the word is incorrect, select one of the suggestions, or retype the word in the Change To text box, and then click Change. If Photoshop questions a specialized term that is spelled correctly, the user may choose to either Ignore the word, by clicking on the Ignore button, or choose the Add button to add the word to the current custom dictionary. The next time spelling is checked, Photoshop will not question the new term unless it is misspelled.

Save a file with Layers

Any time a Photoshop file has layers, at least one of the files that is saved must be a .psd file. A .psd file is an essential file type to save a Photoshop file as because it will preserve all layers in the document, which will allow anyone who opens the file to be able to view and edit all layers in the file.

Saving a PSD file

To save the Photoshop document as a .psd, navigate to the File menu and select Save.

On the Save As window, choose the location to save the file by selecting the drive on the left side of the window, enter a name for the file in the File name text box, verify the Save as type has Photoshop (*.PSD; *.PDD) selected, and verify the Layers option on the bottom of the window is checked. (By default, the Photoshop .psd file type and the layers options will be selected.) When all changes have been made and settings verified, click on the Save button.
It is recommended to always have a current copy of the file as a .psd in case the file ever needs to be edited with all layers intact.

**Save a TIFF file**

When creating a document for commercial print, it is recommended to save the file as a TIFF file. TIFF files are considered a lossless compression file, meaning the file will not lose any image data as it is created.

TIFF files can also be used to save the layers within a Photoshop document, but any time a TIFF file saves layers, it will also create a flat file with the layers, which results in larger file sizes than what a PSD layered file creates.

To Save a file as a TIFF for commercial print, click on the File menu and select Save As, or use the shortcut of Shift-Ctrl-S.

On the Save As window, navigate to the appropriate folder and provide a name for the file. Click on the Save as type dropdown and select the TIFF option, which is located at the bottom of the dropdown.

When these changes have been made, click on the Save button on the bottom right.
**Note:** On the bottom of the Save As window, there are options to Save as a copy, save layers, etc. Ignore these options for right now as these options will also appear when clicking on the save button because Photoshop will populate the TIFF options window.

The TIFF options screen will populate where there are several options to consider before saving the image.

### Image Compression

Image Compression will allow for the TIFF image to be compressed, resulting in a smaller file size.

- **NONE** - Selecting this option results in no compression.
- **LZW** – A lossless compression scheme that will result in a lower file size without destroying image data.
- **ZIP** – A lossless compression scheme. ZIP is best chosen over LZW when the image has large areas of the same color in an image.
- **JPEG** – A compression option that will destroy image data, but will result in the smallest file size.

### Pixel Order

Interleaved is typically the best option for Pixel Order. As the image is saved, one byte of Red information is saved, then one byte of Green information, and then one byte of blue information. If Per Channel is selected, all bytes of Red are stored, then all bytes for Green, and then all bytes for blue.

### Byte Order

Byte order does not hold a lot of significance in creating a TIFF, as all modern applications that support TIFF files are capable of reading both byte orders.
Layer Compression

Layer compression allows for the option to save the TIFF as a layered document. When creating a TIFF, layers are not necessary, so the best option is the bottom option, Discard Layers and Save a Copy.

**Note:** Make sure that the file was saved as a PSD, which will have all layers within the document. When all settings have been made, click on the OK button on the upper right corner of the TIFF Options. Photoshop will now save the file as a TIFF file.

Save a PNG file

PNG files are also a lossless compression file, but they differ from TIFF files in that PNG files also support transparency. If the original file has a transparent background, the background will come out as transparent and not be filled in with white, as other file types will do.

To save a file as a PNG, click on the File menu and select Save As.

On the Save As window, navigate to the appropriate folder and provide a name for the file. Click on the Save as type dropdown and select the PNG option.

When these changes have been made, click on the Save button on the bottom right.

The PNG Options window populates with options for Compression and Interlace.

In almost all occurrences, the default settings of Smallest compression and None for interlace are going to be the best options when creating a PNG file.

**Note:** If the compression option is changed to None, the file size will be very large. If the Interlace option is set to Interlaced, the image will load very odd in a web browser.

Once the PNG options have been verified, click on the OK button to save the file. PNG files do save slowly so it may take a little bit for the file to be produced.
Save a JPEG file

JPEG files are considered lossy compression files, which means the colors of the pixels are rewritten as the file is created, which results in a loss of image data and the quality of the overall image. JPEG files are best used with photographs of scenes with smooth variations of tone and color as well as web usage. Every time an image is saved as a JPEG, it will be losing image quality, so if an image is going to be edited multiple times, it is best to perform the edits in a lossless compression format (TIFF or PNG) and then convert the image to a JPEG if needed.

The benefit to creating JPEGs is the small file sizes compared to most other image file types.

To create a JPEG file, navigate to the File Menu and choose Save As

On the Save As window, navigate to the appropriate folder and provide a name for the file. Click on the Save as type dropdown and select the TIFF option, which is located at the bottom of the dropdown.

When these changes have been made, click on the Save button on the bottom right.

The JPEG options window will populate where there are a couple of options to look at and adjust.
**Image Options**

Image options will allow for the quality of the image to be changed by selecting a Low, Medium, High or Maximum value from the dropdown, or by typing in a number from 0 (lowest) to 12 (highest) in the text box next to Quality. As these settings are changed, the image size, which is displayed below the Preview checkbox, will change based on the quality settings that are selected or typed.

To view how the settings are affecting the image, as long as the Preview button is checked, the image will reflect the changes based on quality as a preview. To view the difference in pixels, the image may have to be zoomed in on, depending on the size and the quality of the image.

**Note:** The shortcut to zoom in is Ctrl + (plus) and the shortcut to zoom out is Ctrl – (minus). Typically, a quality setting of Maximum (or a value of 12), is sufficient and will still reduce the file size from the original size enough to save some space.

**Format Options**

Format options specifies the format of the JPEG file.

- **Baseline (“Standard”)** uses a format recognized by most web browsers.
- **Baseline Optimized** creates a file with optimized color and a slightly smaller file size.
  - This file type may not be recognizable by some of the early web browsers
- **Progressive** will allow an image to display gradually as it is loaded on a webpage. This is not a very good option when creating a JPEG as most users now have a fast Internet connection.

When the settings have been selected, click on the OK button to save the image.